Chapter 4

Using a Word Processor

W)rd is the Microsoft Office word processor application. This chapter
introduces Word for creating letters and simple documents. Modifying a
document and collaborating on a document are explained.

What is a Word Processor?

A word processor is a computer application for creating, modifying,
printing, and e-mailing documents. It is used to produce easy-to-read,
professional-looking documents such as letters, résumés, and reports. The
Microsoft Word 2003 window looks similar to:
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The Word window displays information about a document and includes

tools for working with documents:

¢ The file name of the current document is displayed in the title bar.
The name Document! is used temporarily until the document is

saved with a descriptive name.

¢ Select commands from menus in the menu bar.
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Overtype Mode

Overtype mode means that as
text is typed it replaces exist-
ing text, instead of inserting
characters. Overtype mode is
on if the OVR indicator on the
status bar is not dimmed:

0k

To turn off overtype mode,
double-click OVR on the sta-
tus bar or press the Insert key
on the keyboard.

TIP Press and hold an arrow
key to move the insertion point
in that direction.

One Space After a
Period

How many spaces are typed
after a period? Only one space
is needed because the distance
between each character is
adjusted proportionally, mak-
ing text easy to read.

inserting symbols
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¢ Click a button on the toolbar to perform an action. Click the New
Blank Document button () to create a new document.

¢ The rulers show the paper size. Markers on the rulers are used for
formatting text.

* The vertical line is the insertion point that indicates where the next
character typed will be placed. In a new document the insertion
point is in the upper-left corner. It blinks to draw attention to its
location.

¢ View information about the current document in the status bar.

¢ Links for opening a document or creating a new document are in
the Getting Started task pane. Click the arrow in the Other Task
Panes list to select a different task pane to display. Click the Create
a new document link for new document options.

Creating Document Text

In a word processor document, typed text is placed at the insertion
point. Press a letter, number, or symbol key to place that character in
the document at the insertion point. Press and hold the Shift key while
pressing a key to insert uppercase letters or the character shown above a
number or symbol.

Some keys on the keyboard are used to perform actions, such as moving
the insertion point or deleting text. The arrow keys move the insertion
point within existing text without erasing or entering text.

Together, the Ctrl key (Control) and an arrow key move the insertion
point from word to word in a document. For example, press and hold the
Ctrl key and then press the right arrow key to move the insertion point to
the beginning of the next word to the right.

Press the Home key or End key to move the insertion point to the begin-
ning or end of a line of text, respectively. Ctrl+Home moves the insertion
point to the beginning of the document, and Ctrl+End to the end.

To erase the character directly to the right of the insertion point, press
the Delete key. Deleting a character moves the characters to its right to fill
the gap.

Press the Backspace key to erase the character directly to the left of the
insertion point. Characters to the right move over to fill the gap.

To end a paragraph or to terminate a line of text, press the Enter key.
Pressing Enter ends the current paragraph and creates a new one. Press
Enter twice to create a blank line after the current paragraph.

There are symbols that do not appear on the keyboard, such as the copy-
right (©) and degree (°) symbols. To insert such symbols into a document,
select Insert = Symbol to display the Symbol dialog box. Click a symbol and
then select Insert to place the symbol at the insertion point. Other symbols
are displayed in the dialog box by selecting a font in the Font list.



word wrap

TIP When editing, use the
Enter key to end a paragraph
only. Within a paragraph,
allow the word wrap process
to wrap text from line to line.

The 9 Button

The Show/Hide  button may
not initially appear on the
toolbar. In this case, click the
Toolbar Options button (%) on
the toolbar and then click [¥].
Once selected, the button is
added to the toolbar.

Editing Text in a Document

A word processor document is edited, or modified, on the screen. When
editing, first position the insertion point where text is to be typed or
deleted. One way to position the insertion point is by pressing an arrow
key to move the insertion point. To position the insertion point with the
mouse, move the pointer into the document until it changes from an arrow
shape to the I-beam pointer (T). Click the I-beam pointer where the insertion
point should appear.

When text is typed, existing text automatically moves to the right to
make room for the new text. Word automatically determines if the words
to the right will fit on the end of the current line or if some words must
go on the next line. This process is called word wrap.

When text is deleted, remaining text automatically moves to fill the
space. The word wrap process may also cause words to move up from the
lines below when text is deleted.

Select Edit = Undo ([ [+]) to reverse an edit. Select Edit = Redo or Edit =
Repeat ([ [-]) to repeat the last action performed. Click the arrow in the
Undo or Redo button to display a list of the last actions performed. Select
an option from the list to undo or redo that particular action.

Spaces, tabs (discussed later in the text), and paragraphs are not nor-
mally displayed as characters in a document, but they can be displayed
as special symbols. These symbols are called formatting marks and do not
appear on paper when a document is printed:

tab mark

-t/ Tt iegr poed-pdenio show Formatim g marks, s o-thatyou-cane-find-
nistakes lde two-spaces-between wards. fl__

space mark

paragraph mark (Enter)

It is much easier to edit a document when formatting marks are visible.
Display formatting marks by clicking the Show/Hide 1 button ([¥]) on the
toolbar. Click [¥] again to hide the formatting marks.

Practice: Request — part 1 of 2

You will create and save a new Word document. The document is a letter in the block style as defined in The
Gregg Reference Manual Ninth Edition by William Sabin (copyright 2001 Glencoe/McGraw-Hill).

(D START WORD
a. Ask your instructor for the appropriate steps to start Microsoft Word 2003.

b. Look at the word processor window. Note the title bar, menu bar, toolbar, rulers,
status bar, and Getting Started task pane.

c. The blinking insertion point is in the upper-left of the document. Press the right
arrow key. The insertion point does not move because there is no text in the
document.
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(@ TYPETHE LETTER HEADING

Ablock style letter is a letter style that is often used in business. The block style should
also be used by individuals writing to a company or professional organization. A block
style letter contains a heading, opening, body, and closing with all lines beginning at
the left side of the page.

a.

On the Toolbar, click the Show/Hide T button ([¥]) to display formatting marks, if
they are not already showing. A { marker is displayed to the right of the insertion
point.

Note: If you do not see [®] on the Toolbar, click the Toolbar Options button:
s ] u.'liil il ; § P o Rox
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A letter heading includes a return address and date. Press Enter 6 times to move
the insertion point down about 1 inch (2.54 cm).

Type the following address and date, and then press Enter 4 times. Ignore the
purple dotted line:
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(® SAVETHE LETTER

Select File = Save. The Save As dialog box is displayed.

1. Use the Save in list and the contents box below it to select the appropriate
location for the file to be saved.

2. In the File name box, replace existing text with Request and then select
Save.
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@ TYPETHE LETTER OPENING

The letter opening includes an inside address and salutation. Type the following
letter opening and then press Enter twice. Ignore the red wavy line and purple
dotted line:
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(® TYPETHE LETTER BODY

Type the following letter body and then press Enter 2 times after the last paragraph.
Red wavy lines and purple dotted lines may appear. Ignore them for now:

Drearhs. Laurant]

.

I'represent-ihe Arbor-Neighborbood-Association, -which-ine ludes-families-from: 1 Street-throughy
&0-Strect,-cast-of Oak-Averme-and west-of Poplar- Avenue, -We-would like to-participate-in-the-
“Neighborhood Cleanup™campaign.-l-am-writing1o-request-thata-representative: from-your
organization speak-at-ournext-association meeting. -Ourpext-meeting s scheduled-for-2.00-p.m.-
Saturday. April- 16.- 2006 ar-the-Lake-pavilion-in-Poplar-Park §

T

W have-already-started: the-compmgn-by pr Kingrupracbrochure - and: free-tmsh-bags- frome-your
office. -Out-association-is-relving-on-arepresentative to-offer- suggestions-on-a-cleanup-schedule:
and-ar-incentives program - forthe-neighborhood-children 1

.

Thank-you-for-yvour-time.-T look-forward-torhearing from-vou-soon

Ll

Sincerely!

1'

ﬁ

T

Blain- Trevinod

Smdent Name¥
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(® TYPETHE LETTER CLOSING

a. The letter closing includes a complimentary closing and a signature line. Type
Sincerely and then press Enter 4 times.

b. Type Blain Trevi and then select Insert = Symbol. A dialog box is displayed.

1. Inthe Subset list, select Latin-1. (You may need to first change the Font list to
(normal text).) In the Latin characters, click fi:

Sypmibal x|

L' o Feormdl| B s Sytdel- Litrrl b
AJAJAJAIAIECIEIEIEIEITT|T|IT
[olo[olala = [a|ulo|0[0|YIe|B6a
] I
i b

E&é{ﬂﬁﬂa;éjéé TRE
ololalelol=|olulalalaly|p
Fscmrity e svmboi

€[ £[¥|@|®[™x|2|<]|>|+|«|o|pa|p

LATIN 3L AETTLR NYWTTH . Chawschsr codkc OOF § rams: | Rirmccade (e s
| detomet., | | Shorteser... | oot ley crbees

et | [ conce |

2. Select Insert and then select Close. fi has been added to the name.

c. Type o to complete the name. The closing should look similar to:
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@ EDIT THE LETTER
a. In the body of the letter, the time of the meeting needs to be specified. Place the
insertion point just before “Saturday” and then type 2:00 p.m. followed by a
space.
b. Below Blaine Trevifio’s name, type your name.

c. Save the modified Request.

PRINT THE LETTER




red wavy line

TIP If the wrong menu
appears, the pointer may not
have been over the word.

AutoCorrect

The AutoCorrect feature will
automatically correct typing
mistakes, misspelled words,
and incorrect capitalization
as you type. Point to the cor-
rected text and then point to
the blue bar below the text
to display the AutoCorrect
Options button (). Click
this button to display options
for reversing the correction.

green wavy line

Proofreading

Spelling and grammar checkers
can increase the accuracy of
a document. However, proof-
reading a document is still a
very important step in the
editing process. For example,
a word may be spelled cor-
rectly but used inappropriately.
Having a person other than the
author proofread a document
increases the chances of find-
ing spelling, grammar, and
punctuation errors.

Spelling and Grammar Checking

Word includes a spelling checker that automatically checks words as
they are typed. Words typed in a document are compared to those in a
dictionary file. If a word is spelled incorrectly or is not in the dictionary
file, a red wavy line appears below it. To correct the word, right-click it
to display suggested words, and then click the correct spelling from the

menu:
o i e=yaur
Heln

Right-click a word with a red wavy underline to
display a menu of word choices

Because the dictionary file does not contain every word in the English
language, a red wavy line may appear below a correctly spelled word,
such as a proper name. When this happens, the wavy line can be ignored.
It will not appear on paper when the document is printed. To remove the
red wavy line from all occurrences of that word in the document, right-
click the word and select Ignore All from the menu.

Word also has a grammar checker that displays a green wavy line below
a phrase or sentence when a possible grammatical error is detected.
Right-click the text that has a green wavy line to display suggested
corrections:

Moy

el G
T
s Cras

ol | G
£ Lookip...

25 Pute

Right-click a word with a green wavy underline to
display a menu of grammar options

A green wavy line may appear below an acceptable sentence. When
this happens, the wavy line can be ignored, or it can be removed from the
document by selecting Ignore Once from the menu.
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TIP Smart tags can save time
because they perform actions
in Word that would otherwise
require opening another
application.

Smart Tags

Word automatically evaluates text as it is typed to determine if it is
data that can be used in other applications. For example, a person’s name
typed in a document may be useful stored as part of an Outlook contact
for future use. Text recognized as data is marked with a purple dotted
underline, which is called a smart tag indicator:

Jade Baticells . .
1127 Maim Swest_— SNart tag indicator
Holyoke, T 02401

Move the pointer over the smart tag indicator to display the Smart Tag
Actions button ([&]). Click [£] to display a menu with commands for adding
the data as an Outlook contact or removing the smart tag.

Practice: Request — part 2 of 2

You will correct mispelled words and remove the red wavy line from correctly spelled words in a business
letter. Grammar will also be corrected. A contact will be added to Outlook. Word should already be started
with the Request document displayed from the last practice.

(D REMOVE THE RED WAVY LINE FROM CORRECTLY SPELLED LAST NAMES
a. Right-click either “Laurant.” A menu is displayed.

b. Select Ignore All. The red wavy line disappears from both occurrences of

“Laurant.”

c. At the bottom of the letter, right-click “Trevifio” and select Ignore All.

(@ ADD A CONTACT TO OUTLOOK

a. Point to the address “12 Main Street”, which is marked with a smart tag indicator.
The Smart Tag Actions button is displayed.

b. Click the Smart Tag Actions button ([&@]) and then select Add to Contacts. A dialog

box is displayed.

1. In the Full Name box, type Connie Laurant:

|m!_m . | Conni Latiant

2. On the dialog box toolbar, click [ == xa k] A contact is created.

(® REMOVE SMART TAGS
a. Point to “45 Maple Avenue” at the top of the letter. The Smart Tag Actions button

is displayed.

b. Click the Smart Tag Actions button ([Z]) and then select Remove this Smart Tag. The
purple dotted line is no longer displayed.

c. Remove the other smart tags from the letter.

@ SAVEAND CLOSE THE MODIFIED REQUEST
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finding text

replacing text

refining a search

finding formatting marks

The More Button

If additional search options,
such as Match case, are not
displayed, then select the
More button in the Find and
Replace dialog box.

synonyms

antonyms

Research task pane

TIP The thesaurus shows simi-
lar phrases when a phrase is
selected rather than a single
word.

Finding and Replacing Text

A word processor document can be easily searched for a specified char-
acter, word, or phrase. In Word, Edit = Find displays a Find and Replace
dialog box where search text is entered. Word searches a document start-
ing at the position of the insertion point. If a match is found, Word stops
searching and selects the text. The search can be continued until the entire
document has been scanned.

Text can be replaced with other text by using the Replace command, also
in the Edit menu. In this case, search text as well as replace text are entered
in the Find and Replace dialog box.

To make a text search more specific, options such as Match case and
Find whole words only can be selected in the Find and Replace dialog box.
Match case selects text with the same capitalization as the search text. For
example, a search for Cat will not find CAT or cat. Find whole words only
selects text that entirely matches the search text. For example, a search for
fin will not find finer, stuffing, or muffin.

Formatting marks and other special characters are entered as search text
by making a selection from the Special list at the bottom of the Find and
Replace dialog box. For example, it may be helpful to find all the occur-
rences of the word tip at the beginning of a paragraph. Since all (except
the first) paragraphs in a document have a paragraph mark before them,
precise search text is entered by selecting Paragraph Mark from Special
and then typing tip.

Using a Thesaurus

A thesaurus is a collection of synonyms, which are words that have simi-
lar meanings. For example, “chilly” is a synonym for “cool.” A thesaurus
also provides related words, phrases, and antonyms, which are words with
opposite meaning. For example, “hot” is an antonym for “cool.” In Word,
place the insertion point in a word and then select Tools = Language =
Thesaurus to display the Research task pane with Thesaurus results. To
replace the selected word with one from the Research task pane, click the
arrow to the right of the word and select Insert from the displayed menu.
Thesaurus results can also be displayed by right-clicking a word, which
displays a menu with a Synonyms command.

Word uses a file for the thesaurus which does not contain every pos-
sible word in the English language. If the selected word cannot be found,
suggested spellings are displayed in the Research task pane.

Practice: HANDBOOK

You will customize a company employee handbook. Word should already be started.

(D OPEN HANDBOOK

Open the HANDBOOK document, which is a Word data file for this text. Company
etiquette rules are listed.
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@ FIND TEXT
a. Select Edit = Find. The Find and Replace dialog box is displayed.
Note: Your dialog box may show additional find options.

b. In the Find what box, type: telephone
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c. Select Find Next. The first occurrence of “telephone” after the insertion point is
selected.

d. Select Find Next. Another occurrence is selected.

e. Continue to select Find Next until Word has finished searching the document. Did
you notice that “telephone” with a lowercase t as well as “Telephone” with an
uppercase T were found?

(® MODIFY SEARCH CRITERIA
a. In the Find and Replace dialog box, select More if the search options are not
displayed.
b. Select the Match case check box:
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c. Select Find Next. A lowercase “telephone” is found.

d. Continue to select Find Next until all occurrences have been located. Select OK to
remove the dialog box. Did any of the selected words contain an uppercase T?

@ FIND A SPECIAL CHARACTER
a. In the Find what box, replace “telephone” with: e-mail
b. Select Special and then select Paragraph Mark:
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Check that the Find what criteria is: e-mail™p

. Clear the Match case option.

Select Find Next. “E-mail” followed by a paragraph marker is selected.

Continue to select Find Next until all occurrences have been located. Select OK to
remove the dialog box. Were there any other occurrences of e-mail at the end of a

paragraph?
Select Cancel. The dialog box is removed.

® CUSTOMIZE THE HANDBOOK
a. Select Edit = Replace. The Find and Replace dialog box is displayed.

b.

Note: Your dialog box may show additional find and replace options.

In the Find what box, type: XYZ Company

c. In the Replace with box, type: Widget Corporation
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d. Select Find Next. The first occurrence is located and selected.

e. Select Replace. The selected text is replaced with Widget Corporation and the rest

of the text is scanned for another occurrence.
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f. Continue to select Replace to change all occurrences of XYZ Company to Widget
Corporation. Select OK to remove the dialog box.

g. Close the Find and Replace dialog box.
® USEATHESAURUS

a. Place the insertion point in the word “Gathering,” which is the third subheading
of the document.

b. Select Tools = Language = Thesaurus. The Research task pane is displayed with
thesaurus results for “Gathering.”

c. In the task pane, point to “meeting,” click the arrow, and then select Insert:
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The word “Gathering” is replaced by “Meeting.” Note that Word used the appro-
priate capitalization.

d. Find and replace all other occurrences of “gathering” with “meeting.” Close the
dialog box when done.

@ FIND A SYNONYM FOR THE WORD ESCORT
a. In the last paragraph, right-click the word “escort.” A menu is displayed.

b. In the menu, select Synonyms and then select accompany. The word “accompany”
replaces “escort.”

SAVE, PRINT, AND THEN CLOSE THE MODIFIED HANDBOOK
a. Type your name after the last paragraph in the document.
b. Save the modified HANDBOOK, print a copy, and then close the file.

.
Selecting Text

Editing is faster when text to delete or change is selected first. Select
text by dragging the I-beam pointer over any amount of text, from a
single character to several pages. Selected text is shown highlighted on the
screen:

The Lallipaige Bawd i Lo tps -l lperf orm-the i e i vo o8 ™ Cires 8 Ui 888U Rd i 51
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thesagh Sunday.

The second sentence is selected

Type to replace selected text with new text. Press the Backspace key or
Delete key to remove the selected text. Click anywhere in the document or
press an arrow key to remove the selection without deleting the text.
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TIP Using Ctrl key short-
cuts for Cut (Ctrl+X), Copy
(Ctrl+C), and Paste (Ctrl+V)
may improve productivity
because your hands do not
need to leave the keyboard.

The Paste Options
Button

Click the Paste Options but-
ton ([ +)) to display formatting
options after pasting text.

Clipboard

Office Clipboard

moving and duplicating
between documents

In addition to dragging the I-beam pointer, other ways to select text
include:

¢ Double-click a word to extend the selection from the first character
to the space after the word.

* Hold down the Shift key and click a character to extend the selec-
tion from the insertion point to the character clicked.

* Hold down the Shift key and press an arrow key to extend the
selection from the insertion point to the character in the direction
of the arrow key. Hold down both the Ctrl and Shift keys and
press an arrow key to extend the selection from the insertion point
to the word in the direction of the arrow key.

* Hold down the Ctrl key and click to select the sentence clicked.

* Move the pointer to the left of the text (near the left edge of the
page) until the pointer turns into a right-pointing arrow () and
click to select the line of text to the right. Double-click to select the
entire paragraph, and triple-click to select the entire document.
Drag up or down to select multiple lines of text.

e Edit = Select All to select all the text in the document.

Cut, Copy, and Paste

Editing a document often requires moving and duplicating text. Moving
text means that selected text is “cut” from one place in a document and
then “pasted” into another place. Duplicating text means that selected
text is “copied” from one place in a document and the copy “pasted” into
another place. The Cut (E), Copy (), and Paste (@) commands from
the Edit menu are used to move and duplicate text.

There are four steps to move or duplicate text:

1. Select the text to be moved or copied.
2. Select either Cut or Copy.

3. Place the insertion point in the document where the text is to be
inserted.

4. Select Paste.

Cut or copied text is placed on the Clipboard, which is a designated area
in memory. Paste places the most recent contents of the Clipboard at the
insertion point. Text on the Clipboard remains there until different text
is cut or copied or the computer is turned off.

The Office Clipboard stores the last 24 cut or copied items. Select Edit =
Office Clipboard to display the Clipboard task pane. Point to an item and
then click the arrow to display Paste and Delete commands.

Text can be moved and duplicated between two or more documents.
For example, cut text from one document can be pasted into a different
document. Similarly, copied text can be pasted into a different document.
After cutting or copying from one document, display the second docu-
ment, position the insertion point, and then paste.
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Practice: ORIENTATION — part 1 of 4

You will edit a company orientation handout. Word should already be started.

(D) OPEN ORIENTATION

a. Open the ORIENTATION document, which is a Word data file for this text. The
Widget Corporation employee orientation document is displayed.

b. Display all characters, if they are not already showing.

(@ MOVE A PARAGRAPH

a. Select the second paragraph of text after the “Introduction” heading. Also include
the blank paragraph marker before the paragraph of text. To select the paragraphs,
drag the pointer from the blank paragraph to the paragraph marker at the end of
the text, similar to:

b. On the toolbar, click the Cut button ([4]). The paragraph is removed from the
document and placed on the Clipboard.

c. Place the insertion point just after the last paragraph in the Introduction, which
starts “Our orientation is....”

d. On the toolbar, click the Paste button ([£]). The paragraph from the Clipboard is
pasted into the document.

e. Save the modified ORIENTATION.

(3 PASTE TEXT FROM ANOTHER DOCUMENT

a. Open the HANDBOOK document, which was modified in an earlier practice in this
chapter.

b. Scroll to view the “Meeting” information at the bottom of the page.

c. Place the insertion point just to the left of the second etiquette rule that reads “Use
a handshake....”

d. Press and hold the Shift key and then click at the end of the text that reads “...on
the right shoulder.” The selection includes:

e. On the toolbar, click the Copy button ([E2). The text is copied to the Clipboard.
f. Close HANDBOOK. The ORIENTATION document is again displayed.

g. Select Edit = Office Clipboard. The Clipboard task pane is displayed with the copied
etiquette rules.

h. Scroll the ORIENTATION document to display the first paragraph in the “What
You Need to Know” section.

i. Place the insertion point in the second blank paragraph after “...please be sure

R

to:
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j- Inthe Clipboard task pane, click the etiquette rules. The etiquette paragraphs are
copied into the ORIENTATION document:

1

Acetrodong Pt < Themormsng- g ewalbra comsereal- br ek St -Donng-dus
- yeurihidd-micodut-rnred Mirohe-argloes Arpe-SieriWndgd Haudback -
phssehrfueioy

1
Useatoesishaiee frgedmg 1

Wik s eta g lagh o thevighe-dhaulder |

1 =
L’.-.H-_u'n;,-ﬁsn:ra-'h'lu'JluuﬂMle'i'd-udE'm:tWhhr.dJMktMHh gy g

k. Type your name after the last paragraph in the document.
. Save the modified ORIENTATION and print a copy.

A
Formatting Characters

Using Fonts and Sizes
Effectively

Using too many different fonts
can make a document look
cluttered and unprofessional.
Keep it simple by using only
two or three fonts per docu-
ment. The size of text also
affects the look of a document.
To help the reader distinguish
between headings and body
text, body text is usually 8 to
14 points and headings are at
least 2 points larger than the
body text, usually 12 to 72
points.

TIP Type all of the text in a
document first and then go
back and apply formatting.

The way text appears on a page is called its format. Font, size, and style
define a character’s format. A font or typeface refers to the shape of charac-
ters. The default font in Word is Times New Roman. There are also special
fonts, such as Wingdings, that contain pictures called dingbats. Note how
each font shapes characters differently:

Tahoma: ABCDEF abcdef 1234567890

Times New Roman: ABCDEF abcdef 1234567890
Comic Sans MS: ABCDEF abcdef 1234567890
Courier: ABCDEF abcdef 1234567890
Wingdings: §&os=e [HEEFHEIEBw

The size of text is measured in points, and there are 72 points to an inch.
For example:

This is an example of 8 point Tahoma.

This is an example of 10 point Tahoma.

This is an example of 12 point Tahoma.

This is an example of 14 point Tahoma.

The way in which a character is emphasized is called its style. The most
common styles are bold, italic, and underline:

Bold text is printed darker so that words and phrases stand out on
a page. It is often used for titles and headings.

Italic text is slanted and is mostly used for emphasis. It is sometimes
used for headings.

Underline text has a line under it and is mostly used for emphasis.
It is sometimes used for the title of a publication.

Regular text, sometimes called normal text, is the default style.
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Marks for Footnotes
and Endnotes

Footnotes and endnotes
are usually marked with
superscripted text. Creating
footnotes and endnotes is
described in Chapter 5.

TIP To keep your hands on
the keyboard while format-
ting, use the Ctrl key to bold
(Ctrl+B), italicize (Ctrl+1),
underline (Ctrl+U), super-
script (Ctrl+Shift+=), and sub-
script (Ctrl+=) text. Pressing
Ctrl+spacebar removes any
applied styles from selected
text.

TIP Always preview a docu-
ment before printing to see
document formatting because
print preview displays an entire
page at once.
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Another text style is superscript, which reduces the size of the text and
raises it to the top of the current line. Subscript is a text style that reduces
the size of the text and lowers it to the bottom of the current line. In the
following example, the “th” after the 5 is a superscript, and the “2” in H,O
is a subscript:

In her 5% Avenue boutique, Dina Johannsen sold her designer
perfume called "DJ’s H,0.”

Text color can also be changed to emphasize headings, subheadings, and
other text. Color should be applied with readability in mind. Bright colors
and many colors in a single document are not usually recommended.

Format characters by first selecting the text. Next, select Format = Font
to display the Font dialog box with options for changing the font, style,
size, and color of selected text. The Font dialog box is also displayed by
right-clicking selected text and then selecting Font from the menu.

The Font box ([Ties Mew v [+]) and Font Size box ([iz [+]) on the toolbar
can also be used to change the font and size of selected text. The Bold ([&]),

Italic (), and Underline () buttons on the toolbar can be used to apply
or remove character styles from selected text. The Font Color button ([&]+])
can be used to change the font color. More than one button can be used at
a time text to apply multiple styles.

Previewing a Document

A document can be previewed to see how it will appear when printed.
Select File = Print Preview or click the Print Preview button (@) on the
toolbar to display the Print Preview window:

T

P L Jac 1 = T W Cd A H_

Once in print preview, the document can be viewed in different ways:

* Press the Page Up key or Page Down key to display the previous
or next page, respectively.



¢ Use the vertical scroll bar to view previous and next pages.

* Move the pointer onto the document and then click the magnifying
glass (@) to zoom into that portion of the page. Click again to
display the entire page.

Select the Print button ([]) on the toolbar to print a copy of the docu-
ment using the default printer settings. Click on the toolbar or press
the Esc key to return to the document window.

Practice: ORIENTATION — part 2 of 4

You will format a company orientation handout. Word should already be started with the ORIENTATION
document displayed from the last practice.

(® FORMAT THE ENTIRE TITLE

a. At the top of the document, select the entire title “Widget Corporation Employee
Orientation.”

b. Select Format = Font. A dialog box is displayed.
c. Change the Font to Arial, the Font style to Bold, the Size to 16, and the color to

green:
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d. Select OK. The title is formatted:

Widget-Corporationf|
Employee-Orientationy

1
Inteedustreny
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(@ FORMAT TEXT USING THE TOOLBAR
a. In the next line, select the “Introduction” title.
b. On the toolbar, click the Italic button (). The selected text is italic.
c. On the toolbar, click the Bold button (). The selected text is now both bold and
italic.

d. Click anywhere in the document to remove the selection.

(® FORMAT THE REMAINING TWO TITLES AS BOLD AND ITALIC

a. Scroll down page 1 until the “What You Need to Know” title is displayed, and then
select the title.

b. Right-click the selected text. A menu is displayed.
c. Select Font from the menu. A dialog box is displayed.
1. In the Font style list, select Bold Italic.
2. Select OK. The dialog box is removed and the selected text is bold and
italic.
d. Click anywhere to remove the selection.

e. Use either of the methods in Steps 2 and 3 to format the “See You Soon” title as
bold and italic.

@ UNDERLINE A PHRASE IN THE INTRODUCTION
a. Scroll to the top of page 1.

b. Select the words “pleased to have you” in the second sentence of the paragraph
that begins “Welcome! ....”

¢. On the toolbar, click the Underline button (). The selected text is underlined.

d. Click anywhere to remove the selection.

(® REMOVE FORMATTING

a. Place the insertion point just to the right of the “d” in “pleased to have you” in the
underlined text.

b. Hold down the Shift key and then press the right-arrow key until “to have you” is
selected.

c. On the toolbar, click the Underline button. The selected text is no longer
underlined.

d. Click anywhere to remove the selection. Only the word “pleased” is underlined.
Check - Your document should look similar to:

Widget Conporationd
Employee-Orientation
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@ PREVIEW THE DOCUMENT
a. Save the modified document.

b. On the toolbar, click the Print Preview button ([_1]). ORIENTATION is displayed in
the Print Preview window.

c. Point to the middle of the page. The pointer changes to a magnifying glass ().

d. Click in the middle of the page. The document is magnified.

e. Click again in the middle of the page. The entire page is displayed in the

window.

f. Scroll down, if necessary, to display the second page of ORIENTATION.

@ PRINT THE DOCUMENT
a. Press the Page Up key to display page 1 of the document.
b. On the toolbar, click the Print button ([4]). The document is printed.

¢. On the toolbar, click . The Print Preview window is closed and the document
window is displayed.

A
Paragraph Alighment

Format Painter

To copy entire paragraph for-
mats from one paragraph to
another, place the insertion
point in the paragraph that
contains the formatting to be
copied and click the Format
Painter button ([#]) on the
toolbar. The formats are cop-
ied and the pointer changes to
£I. Click another paragraph to
apply the formatting.

TIP Right-click a paragraph
to display the Paragraph
command.

The alignment of text in a paragraph refers to its position relative to the
sides of the page:

| eft a l I g n ed —__| The scientific classification of the zebras are as follows:

|~ mountain zebra is Equus zebra, Burchell’s zebra is Equus
burchelli, and Grevy’s zebra is Equus grevyi.

The scientific classification of the zebras are as follows:
mountain zebra is Equus zebra, Burchell’s zebra is Equus
burchelli, and Grevy’s zebra is Equus grevyi.

centered —

rl g ht a l I g n ed — The scientific classification of the zebras are as follows:
mountain zebra is Equus zebra, Burchell’s zebra is Equus

burchelli, and Grevy’s zebra is Equus grevyi.

JUSUﬁed —|_The scientific classification of the zebras are as follows:
mountain zebra is Equus zebra, Burchell’s zebra is Equus
burchelli, and Grevy’s zebra is Equus grevyi.

Left aligned is the default and means that the left edge of a paragraph
is straight and the right edge of the paragraph is jagged. This format is
most often used in letters and research papers. Centered means that the
left and right edges of the paragraph are equally distant from the left
and right sides of the page. Headings and titles are often centered. Right
aligned means that the right edge of the paragraph is straight and the left
edge is jagged. Justified alignment creates straight edges at both sides of a
paragraph and is often used in newspapers and books.

The Align Left (El), Center (El), Align Right (Iil), and Justify (IE')
buttons on the toolbar can be used to apply a paragraph alignment. To
format multiple paragraphs together, first select the paragraphs and then
click an alignment button.

The Paragraph dialog box can also be used to format paragraphs. Select
Format = Paragraph to display the dialog box. Click the Indents and Spacing
tab to display options for changing alignment.
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Practice: ORIENTATION — part 3 of 4

You will continue to format ORIENTATION. Word should already be started with the ORIENTATION docu-
ment displayed from the last practice.

(D CENTER THE FIRST TWO LINES IN THE DOCUMENT

a. Atthe top of page 1, place the insertion point anywhere in the “Widget Corporation”
title.

b. Select Format = Paragraph. A dialog box is displayed.
c. Change the Alignment to Centered:
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d. Select OK. The dialog box is removed and the text is centered.

e. Place the insertion point in the next line of the document: “Employee
Orientation”

f. On the toolbar, click the Center button (El). The text is centered.

(2 JUSTIFY THE PARAGRAPHS IN THE INTRODUCTION

a. Place the insertion point anywhere in the paragraph that begins “Welcome! Widget
Corporation....”
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b. Hold down the Shift key and click in the last paragraph of the introduction, which
begins “Now in our twentieth year....” Each paragraph in the Introduction now
contains some selected text:

Welcome e ".l-. Apet Comporatiasre u-[lr:l.-r dda-have powary e emberabomrieam “Widpet
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mongly

c. On the toolbar, click the Justify button ([=]). The paragraphs are justified.
d. Click anywhere to remove the selection.

(® SAVE THE MODIFIED ORIENTATION

.
Hyperlinks in a Document

TIP If your hyperlink isn’t
automatic, select Tools =
AutoCorrect Options to display
a dialog box. Select the
AutoFormat As You Type tab and
then select the Internet and
network paths with hyperlinks
check box.

TIP Refer to Chapter 2 for
more information on the
Internet and URLs.

removing a hyperlink

When a Web site address is typed in a document, Word automatically
turns it into a blue, underlined hyperlink. For example, after the URL
www.lpdatafiles.com is typed, Word formats that text as blue underlined
characters. A reader viewing the Word document on screen can press the
Ctrl key and then click the link to follow a hyperlink. Holding down the
Ctrl key changes the pointer to . Clicking 1 displays the Web page in
a browser window if there is an Internet connection.

Word also recognizes an e-mail address and formats it as blue under-
lined characters. A reader viewing the Word document on screen can
press the Ctrl key and then click the link to display a new e-mail message
window.

The Insert Hyperlink dialog box contains options for inserting a
hyperlink into a document. To use this dialog box, select Insert = Hyperlink
or click the Insert Hyperlink button ([#]) on the toolbar. Select a type of
link from the Link to list and then type a label in the Text to display box.
For Web page links, type a URL in the Address box. For an e-mail address
link, type an address in the E-mail address box. The label is placed at the
insertion point, but the URL will be followed when the reader clicks the
label.

To remove the blue underline from text, right-click the link and then
select Remove Hyperlink from the menu. The text remains, but is no longer
a hyperlink.
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Practice: ORIENTATION — part 4 of 4

You will add an e-mail contact and Web site address to ORIENTATION. Word should already be started with
the ORIENTATION document displayed from the last practice.

(® ADD AN E-MAIL CONTACT AND A WEB SITE ADDRESS

a.

Scroll to the end of the document.

b. Place the insertion point just before the period in the last sentence that ends “human

resources at extension #3872...."

Type a space and then type: or e-mail widget@lpdatafiles.com

. Place the insertion point after the period following the e-mail address and type a

space. The e-mail address becomes blue and underlined.

Type the sentence: You may also download this document from our Web site at
www.lpdatafiles.com/widget.

Type a space after the period. The link becomes blue and underlined.
Save the modified ORIENTATION.

Check — Your document should look similar to:

Kawr Fon Kpon Y

1

Widges Corporatiogris-glad-tehave-yowomrboard “Webook-forsard: toesrpre-duc trve-
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siewtwanw bpedatafiles comiwidget him 4

(@ TEST THE HYPERLINK

a.

b.

This step requires a browser and Internet access. If either of these are not available,
then skip this step.

Press and hold the Ctrl key and then click www.lpdatafiles.com/widget.htm. A

browser window is opened and the Web site displayed.

Close the browser window.

® SAVE, PRINT, AND CLOSE THE MODIFIED ORIENTATION

N
Document Collaboration

Document collaboration means working with others to create, review, and
revise a document to achieve the desired result. One form of collabora-
tion is peer editing. It is always a good idea to have a peer edit a document

TIP The TRK indicator on the because it is often difficult to catch mistakes, especially in a lengthy docu-
Status bar is bold when track- ment that has been worked on for an extended time. Peer editing often
ing changes. involves “suggested” changes instead of changes that have to be made,

such as spelling errors.

The peer editing process can involve providing a printout for a peer to
mark edits, but this can be inefficient and inconvenient. Another way to
gather input from a reviewer is to provide the document as a file which
tracks changes. This method allows the reviewer to type edits and com-
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ments directly into the document itself. Changes will be recorded as they
are made so that the original author can later decide which changes to
keep and which to discard. To modify a document to track changes, select
Tools = Track Changes. When the reviewer makes changes in a document
that is tracking changes, edits appears similar to:

"'1] | vl f P+ Bl vt i

Reviewing toolbar—
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TIP Refer to Chapter 2 for more
on e-mail and attachments.

When tracking changes, a Reviewing toolbar is displayed at the top of
the Word window. The Insert Comment button () can be used by the
reviewer. Other buttons are used by the original author to select the previ-
ous () or next () edit, to accept a change and merge it into the selected
document ([z2]-]), and to reject a change or delete a comment ([s2]+]).

E-Mailing a Document

E-mail is a fast and efficient message delivery system. In Word, the
content of a document can be e-mailed as a message. To e-mail a message,
open the document in Word and then click the E-mail button (m) on the
toolbar, which displays the address information boxes. Type the e-mail
address of the recipient in the To box. The file name of the document
automatically appears as the Subject. Type text in the Introduction box if
additional information should appear in the e-mail message and then click

to send the message.

Messages e-mailed from Word appear directly in the body of the e-mail.
To send a document as a separate file to an e-mail recipient, the document
should be sent as an e-mail attachment. Select File = Send To = Mail Recipient
(as Attachment) to display an e-mail window with the document included
as an attachment file.

When collaborating on a document, select File = Send To = Mail
Recipient (for Review) to send a document as an attachment that will track
changes when opened by the recipient. After the reviewer has made
edits, |Frspyuandane: .. | on the Reviewing toolbar is clicked to e-mail the
document back as an attachment. The original author will be prompted to
merge any changes into the existing document. Selecting Yes overwrites
the existing file with the new. Selecting No displays the new document
with a name similar to the old, allowing the new version to be saved
separately from the existing version.
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Reading a Document on Screen

Reading Layout view Reading Layout view makes it easier to read a document that is displayed
on the screen. In this view, text is larger and word wrap is changed so that
fewer words appear on a line. The reader can use the Page Up and Page
Down keys or the scroll bar to scroll through the pages of the document.
Reading Layout view is the default view when an e-mail attachment is
opened in Word. Make edits in Reading Layout view or click the Close
button to switch to Page Layout view.

Practice: Benefit

You will e-mail a document to a peer for editing. This practice requires Outlook and Internet access. You
are also required to work with a classmate and exchange documents through e-mail. Word should already
be started.

(@D CREATE NEW A DOCUMENT
a. On the toolbar, click the New Blank Document button (). A new document is
displayed.
b. In a new document, type the following:
[ am looking forward to my Widget Corporation orientation. I believe I will
benefit most from

c. Complete the document by reading the ORIENTATION printout from the last
practice and then writing about one thing that will occur at the orientation that
you feel will be beneficial if you were the new employee.

d. Save the document naming it Benefit Name where Name is your name.

(@ E-MAIL A DOCUMENT FOR REVIEW

a. Select File = Send To = Mail Recipient (for Review). After a few seconds, an e-mail
window is created with the Benefit document as an attachment.

b. If the e-mail window is not displayed, click the “Please review” button on the
Windows taskbar. The e-mail window is displayed. Note the body of the e-mail
contains a “Please review the attached document.” sentence.

c. Inthe To box, type the e-mail address of a classmate.

d. On the Outlook toolbar, click [=25nd]. The e-mail is sent to your classmate for
review.

® REVIEW A DOCUMENT
a. Check your e-mail.

b. Open the e-mail from your classmate. Note that the e-mail message asks you to
review the attached document.

c. Open the attachment. A dialog box may be displayed with information about the
Reading Layout feature.

d. Read through the document and type any suggestions.
e. Place the insertion point at the very beginning of the document.

f. On the Reviewing toolbar, click the Insert Comment button ([]). The insertion
point is moved to the comment.

g. Type Reviewed by and then your name.
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h.

On the Reviewing toolbar, click [+ Fsppwitirance: .. |. After a few seconds, an Outlook
e-mail window is displayed. (If you do not see the Reply with Changes button,
click the Toolbar Options button to display it.)
On the Outlook toolbar, click [ =35]. The document is e-mailed back to the sender.
You may get a warning dialog box. Select Yes.

@ REVIEW CHANGES

a.
b.

0

®w - oo

=n

Check your e-mail.

Open the e-mail reply from your classmate. The e-mail message includes the
reviewed document as an attachment.

Open the attachment. You may get a message about merging changes. Select Yes.
Note that the document is in Reading Layout view.

. On the toolbar, click to view the document in Page Layout view.

Place the insertion point at the very beginning of the document.
On the Reviewing toolbar, click the Next button (). The comment is selected.
On the Reviewing toolbar, click the Reject Change/Delete Comment button

(=D

. On the Reviewing toolbar, click the Next button (). An edit is selected.

Evaluate the edit and then on the Reviewing toolbar, click either the Accept Change
([52)) or Reject Change/Delete Comment button ([5]-]).

Continue clicking the Next button ([#3]) and then accept or delete edits for all the
tracked changes.

Save the modified Benefit document. If prompted to overwrite an existing document,
select OK.

(® CLOSE BENEFIT

(® QUIT WORD

Chapter Summary

This chapter introduced the word processor, which can be used to
produce easy-to-read, professional-looking documents. Microsoft Word

is the word processor application in Microsoft Office.

Keys on the keyboard are used to type text and perform actions in Word.
The Symbol command is used to insert a symbol that does not appear on

the keyboard.

Move the pointer into a document to change it from an arrow shape to
the I-beam pointer. Click the I-beam pointer in text to move the insertion

point to that position.

Word automatically determines if the next word will fit on the end of

the current line or the next line in a process called word wrap.

The last action can be reversed by selecting the Undo command. Select
the Redo or Repeat commands to perform the same action again. Buttons

on the toolbar can be used instead.

Spaces, tabs, and paragraphs are called formatting marks. Formatting

marks are displayed by clicking the Show/Hide 1 button.
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Word includes a spelling checker and a grammar checker. A red wavy
line appears below a misspelled word and a green wavy line below a
phrase when a grammatical error is detected. Right-click a wavy line to
display a menu of suggestions.

If text in a document is one of several types of data commonly used
in other applications, Word designates the text as a smart tag. Move the
pointer over a smart tag indicator to display the Smart Tag Actions button,
which displays a menu of actions when clicked.

To scan a document for search text, use the Find command. Special
characters can be included in search text. Use the Replace command to
change search text to other text.

The Thesaurus command is used to display a the Research task pane
with a list of synonyms and antonyms for a selected word.

Select text by dragging the I-beam pointer over it. Selected text can be
moved or copied using the Copy, Cut, and Paste buttons on the toolbar. Cut
or copied text is placed on the Clipboard. The Office Clipboard is available
in Microsoft Office applications. Clicking an item in the Clipboard task
pane pastes a copy of it at the insertion point.

A font refers to the shape of characters, and the size of text is measured
in points. The way a character is emphasized is called its style. Common
styles are bold, italic, and underline, superscript and subscript. The Font
command is used to format the font, size, style, and color of selected text.
The Font box, Font Size box, and the Bold, Italic, Underline, and Font Color
buttons on the toolbar can also be used.

A document can be previewed to see how it will appear when printed
by selecting the Print Preview command or the Print Preview button.

The alignment of text in a paragraph refers to its position relative to the
sides of the page. The Align Left, Center, Align Right, and Justify buttons
on the toolbar are used to change paragraph alignment. The Paragraph
command displays a dialog box with alignment options.

A document can include hyperlinks to a Web page or to an e-mail
address. A hyperlink in a Word document is automatically formatted as
blue and underlined when it is typed.A hyperlink can also be created
using the Insert Hyperlink button.

To e-mail an open document from Word, click the E-mail button, type
information in the address boxes, and then click [=1za1 a copz]. A document
can also be e-mailed as an attachment. E-mailing attached documents
allows for collaboration and peer editing.



Vocabulary

Alignment The position of text relative to the sides
of the page. Left, right, centered, and justified are
alignments.

Antonym A word that has the opposite meaning
of another word.

Bold text A format that prints text darker.

Centeralignment A formatwheretheleftand right
edges of the paragraph are equally distant from the
left and right sides of the page.

Clipboard A designated area in memory where
cut and copied text is placed.

Dingbat A picture created by a special font such
as Wingdings.

Document collaboration Working with others to
create, review, and revise a document.

Duplicate text Tomakea copy of textand then place
that copy at a different location in the document or
into a completely different document.

Edit To modify the contents of a document on the
screen.

Font The shape of a set of characters.
Format The way text appears on a page.

Formatting marks Special symbols, representing
spaces, tabs, and paragraphs, that do not appear on
paper when a document is printed.

Getting Started task pane A task pane shown in
the Word window with options for creating a new
document.

Grammar checker A feature of Word thatautomati-
cally checks a document for possible grammatical
€errors.

I-beam pointer The shape of the pointer when it
is moved into a document.

Insertion point A blinking vertical line in a docu-
ment that indicates where the next character typed
will be placed.

Italic text A format that makes text slanted.

Justified alignment A format where both sides of
the paragraph are straight.

Left alignment The default format where the left
edge of the paragraph is straight and the right edge
is jagged.

Microsoft Word The word processor application
in Microsoft Office.

Move text Delete text from a document and then
place that textata differentlocation in the document
of into a completely different document.

Office Clipboard Stores the last 24 cut or copied
items.

Peer editing A form of collaboration where a peer
edits a document.

Point The unit used to measure the size of text.
There are 72 points to an inch.

Reading Layout view A Word view that makes
reading a document on screen easier because text
is larger.

Right alignment A format where the right edge
of the paragraph is straight and the left edge is
jagged.

Rulers Located at the top and left side of the docu-

ment window, they are used for measuring and also
contain markers for formatting text.

Selected text Text that is shown highlighted on
the screen.

Smart tag Text in a document that has been des-
ignated by Word to be one of several types of data
commonly used in other applications.

Smart tag indicator A purple dotted underline
that appears under text that has been designated
by Word as a smart tag.

Spelling checker A feature of Word that automati-
cally compares words to those in a dictionary file to
determine if they are spelled correctly.

Status bar A bar at the bottom of the screen that
displays information about the current document.

Style The way a character is emphasized.

Subscript Text that is reduced in size and lowered
to the bottom of the current line.

Superscript Text that is reduced in size and raised
to the top of the current line.
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Synonym A word that has a similar meaning to
another word.

Thesaurus A collection of synonyms.

Title bar A bar at the top of the Word window that
displays the file name of the current document.

Toolbar A bar at the top of the Word window that
contains buttons that are clicked to perform an
action.

Typeface Commonly referred to as font. See font.

Underline text A format that puts a line under
text.

Word The Microsoft word processing application.

Word processor A computerapplication forcreating,
modifying, printing, and e-mailing documents.

Word wrap The process Word uses to determine if
the next word will fit on the end of the current line
or if it must go on the next line.
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Word Commands and Buttons

AcceptChangebutton Makesa tracked change
P 8 g
permanent. Found on the toolbar.

Add to Contacts command Displays a contact form.
Found in the menu displayed by clicking the Smart
Tag Actions button.

[=] Align Left button Left aligns the text in the
selected paragraph. Found on the toolbar.

= Align Right button Right aligns the text in the
selected paragraph. Found on the toolbar.

Bold button Formats selected text as bold.
Found on the toolbar.

[Z] Center button Center aligns the text in the
selected paragraph. Found on the toolbar.

Close button Returns to the document win-
dow from the Print Preview window. Found on the
toolbar in the Print Preview window.

Copy command Adds a copy of the selected
text to the Clipboard, leaving the selected text at
its original location. Found in the Edit menu. The
Copy button on the toolbar can be used instead of
the command.

El Cut command Moves the selected text to the
Clipboard. Found in the Editmenu. The Cutbuttonon
the toolbar can be used instead of the command.

Deletecommand Deletesanitem from the Clipboard.
Found in the clipboard.

[3] E-mail button Displays address information
boxes for sending a document as an e-mail. Found
on the toolbar.

Find command Displays a dialog box used to scana
document for search text. Found in the Edit menu.

Fontcommand Displaysadialogboxused tochange
the font, style, and size of selected text. Found in the
Format menu. Also found in the menu displayed by
right-clicking text.

Fontbox Changes the fontof selected

text. Found on the toolbar.

[=1-] Font Size box Changes the size of selected
text. Found on the toolbar.

[%] Hyperlink command Displays a dialog box used
for inserting a hyperlink into a document. Found in
the Insert menu. The Insert Hyperlink button on the
toolbar can be used instead of the command.

Ignore All command Removes the red wavy line
from all occurrences of that word in the document.
Found in the menu displayed by right-clicking a
word that has a red wavy line.

IgnoreOncecommand Removesthe greenwavyline
fromasentence that contains a possible grammatical
error. Found in the menu displayed by right-clicking
a phrase or sentence that has a green wavy line.

Insert Comment button Adds a comment to
a document. Found on the toolbar.

E Italic button Formats selected text as italic.
Found on the toolbar.

[=] Justify button Justify aligns the text in the
selected paragraph. Found on the toolbar.

Mail Recipient (as Attachment) command Used to
e-mail a document as an attachment. Found in File
= Send To.

Mail Recipient (for Review) command Used to e-mail
adocumentasanattachment that will track changes
when opened by the recipient. Found in File = Send
To.

New Blank Document button Creates a new
document. Found on the toolbar.

New Document task pane Contains links for
opening a document or creating a new document.

Next button Selects the next tracked change.
Found on the toolbar.

Office Clipboard command Displays the Clipboard
task pane with the last 24 cut or copied items. Found
in the Edit menu.

Other Task Panes list List of available task panes.
Found at the top a task pane.

Paragraph command Displays a dialog box used
to apply paragraph formats. Found in the Format
menu. Also found in the menu displayed by right-
clicking text.
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@ Paste command Places the contents of the
Clipboard at the insertion point. Found in the Edit
menu. The Paste button on the toolbar can be used
instead of the command.

@ Previous button Selects the previous tracked
change. Found on the toolbar.

[4] Printbutton Printsa copy of thedocument. Found
on the toolbar in the Print Preview window.

[2] Print Preview command Displays the document
in the Print Preview window. Found in the File menu.
The Print Preview button on the toolbar can be used
instead of the command.

Redo command or Repeat command Performs
the last action again. Found in the Edit menu. The
Redo button on the toolbar can be used instead of
the command.

Reject Change/Delete Comment button
Ignores a tracked change or removes a comment.
Found on the toolbar.

Remove Hyperlinkcommand Removes theblue under-
line from a hyperlink. Found in the menu displayed
by right-clicking the link.

Remove thisSmartTagcommand Removesthe purple
dotted smart tag indicator from text. Found in the
menu displayed by clicking the Smart Tag Actions
button.

Replace command Displays a dialog box used to
search a document for search text and change it to
specified text. Found in the Edit menu.

|Férsptvanangss.. | Found on the toolbar after a
document sent for review has been opened.

Select Allcommand Selectsall the textina document.
Found in the Edit menu.

Sends the content of a document as

an e-mail message. Found on the toolbar after the
E-mail button has been clicked.

[¥] Show/Hide { button Displays formatting
marks. Found on the toolbar.

Smart Tag Actions button Displays the type
of data, the smart tag data, and a menu of actions.
Displayed by moving the pointer over a smart tag
indicator.

Symbol command Displays a dialog box used to
insert symbols not found on the keyboard into a
document. Found in the Insert menu.
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Synonyms command Displays a list of synonyms
and an antonym for a word. Found in the menu
displayed by right-clicking a word.

Thesauruscommand Displays the Research task pane
with synonyms. Found in Tools = Language.

Track Changes command Marksadditions, deletions,
and other changes in a document as they are made.
Found in the Tools menu.

E Underline button Formats selected text as
underlined. Found on the toolbar.

Undo command Reverses the effects of the last
action. Found in the Edit menu. The Undo button on
the toolbar can be used instead of the command.



10.

11.

What is a word processor?

a) What is the insertion point?

b) How can the insertion point be moved down
3 lines and then 10 places to the right without
deleting or entering text?

¢) What is the difference between pressing the
Backspace key four times and the left-arrow
key four times when the insertion point is
located in the middle of a line of text?

d) How can symbols not represented by a key
on the keyboard be added to a document?

a) What is the shape of the pointer when itisin
a document?

b) How can the mouse be used to move the
insertion point?

What is word wrap?

a) What toolbar button is used to reverse the
last action performed?
b) Can an action be repeated? If so, how?

a) What are formatting marks?
b) How are formatting marks useful when
editing a document?

a) What does a red wavy line under a word
indicate?

b) List the steps required to correct a misspelled
word.

c¢) What does a green wavy line under a
sentence indicate?

a) What does a purple dotted line under text
indicate?

b) What is displayed when the Smart Tag
Actions button is clicked?

What is the search text for finding Jerome? What
option should be used to find only occurrences
with an uppercase “J”?

a) In a search for the word hat, how can you
avoid finding the word that?

b) What is the search text for finding the word
The at the beginning of a paragraph.

a) What is replace text?
b) Listthe steps required to find each occurrence
of day and replace it with week.

12.

13.

14.

15.

16.

17.

18.

19.

a) What is a thesaurus?

b) What is a synonym?

¢) What is an antonym?

d) List two places to find a list of synonyms for
the word house in a document.

a) How is selected text shown on the screen?
b) What happens if text is selected and then the
Backspace key is pressed?

List two methods for selecting an entire
paragraph of text.

List the steps required to copy the third
paragraph in a document to the end of the
document.

What is the difference between moving and
duplicating text?

List the steps required to paste an item from the
Office Clipboard to the location of the insertion
point in a document.

a) What does “font” refer to?
b) List five fonts available on your computer.

Fonts can be divided into three categories: serif,
sans serif, and decorative. Serif fonts have small
strokes at the ends of characters that help the
reader’s eye recognize each letter. The horizon-
tal and vertical strokes of the letters often vary
in thickness. Serif fonts are more conventional
and are used in large amounts of text. Sans serif
fonts lack the decorative flourishes of serif fonts.
Sans serif fonts are often used in headings to
contrast with the body text:

fThe [The

Serif No Serif

Decorative fonts have letters that are specially
shaped and are neither serif nor sans serif. Some
decorative fonts have a picture, rather than a
letter, that corresponds to characters.

a) Refer to the “Formatting Characters” section
in this chapter and then list the font name
and category for each of the fonts presented
in the fonts example in that section.

b) List an appropriate use for each type of
font.
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20.

21.

22.

23.

24.

25.

26.

27.

28.

29.

30.

3L

a) What is character size measured in?

b) What kind of text would be appropriate in
size 247

¢) Would text in the body of a letter be better
as size 10 or size 18? Why?

Can text be formatted as both bold and italic?
If so, how?

List the step required to remove bold formatting
from a selected paragraph.

Underlined text is sometimes confused for a
hyperlink. Why?

List two instances of when the subscript or
superscript format should be used.

a) How does a document appear in Print
Preview?

b) Which keys are used to scroll through a
document in print preview?

¢) What does it mean to change the magnifica-
tion of a document? How is this done?

List the steps required to preview an open
document, print a copy, and then return to the
document window.

List the four paragraph alignments and describe
each one.

List the appropriate paragraph style for the

following documents. Use each of the four

alignments (right, left, center, justify) only

once:

a) A birth announcement.

b) A term paper.

¢) A promotional flyer for a very contemporary
advertising agency.

d) A newspaper article.

a) What does Word do when a Web site address
is typed in a document?

b) How can a hyperlink be followed from the
Word document on screen?

a) How does Word format an e-mail address?
b) What happens when a reader presses the Ctrl
key and clicks an e-mail hyperlink?

a) What does document collaboration mean?
b) What are two forms of collaboration?
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32.

33.

34.

35.

What feature does Word have that allows for
reviewing and editing a document between two
or more people?

Can comments be added to a document being
reviewed? If so, how?

a) List three ways a document can be e-mailed
from Word.

b) When should a document be e-mailed as an
attachment?

¢) How should a document be e-mailed to a
reviewer who is collaborating on the docu-
ment? Why?

What is Reading Layout view?

True/False

36.

Determine if each of the following are true or

false. If false, explain why.

a) Pressing and holding the Ctrl key and then
pressing the left arrow key moves the inser-
tion point to the beginning of the previous
word to the left.

b) Pressing the End key moves the insertion
point to the beginning of a line of text.

c) There is no way to create a © symbol in a
Word document.

d) The Enter key should be pressed when a line
of text reaches the right edge of the docu-
ment, even when a new paragraph is not
being started.

e) Double-clicking a word selects that word and
the line of text that it appears in.

f) Text cannot be copied from one document to
another.



Exercise 1 Ceramics Info Request

When writing a letter that requests a response or information, the first paragraph should introduce
the writer and explain the purpose of the letter. The second paragraph should explain any necessary
details of the request and ask any additional questions. The third paragraph should thank the reader
for his or her consideration and emphasize the request.

a) Inanew document create the following letter, allowing Word to wrap the text. Create
the letter using the block style. Be sure to press Enter 6 times before typing the return
address. Refer to the Request practices for more information.

72 Simple Lane
Plain City, FL 33101-1234
September 20, 2006

Ms. Marcia Paloma
Periwinkle Ceramics
Big Pine Lane
Sunport, FL 33568

Dear Ms. Paloma:

[ am enrolled in the introductory ceramics class that you are teaching this
spring. My experience in creating ceramic pieces is limited, but [ have admired
your artwork for many years. I am honored and excited to participate in your
class.

My friend would also like to enroll in your ceramics program. She would like to
be in the same class that I am signed up for, if there are still openings. Please
send a brochure and availability information to the following address:

Kaitlin Pruitt

44 Simple Lane

Plain City, FL 33101-1234

pruittk@lpdatafiles.com

[ understand your classes fill quickly. My friend is eagerly awaiting your reply so
that she may enroll in your class. Thank you very much for your time.

Sincerely

Kallie Gavrilos

b) Check the document on screen and correct any errors and misspellings. Remove the
red wavy line from correctly spelled words.
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c) Save the document naming it Ceramics Info Request and print a copy.
d) Make the following changes to the letter:
¢ Change the word introductory to advanced in the first sentence.
¢ Change the words a brochure to an application in the second paragraph.

* Use the thesaurus to change the word quickly in the fourth paragraph to an
appropriate synonym.

¢ Change Kallie Gavrilos to your name.

e) Save the modified Ceramics Info Request and print a copy.

Exercise 2 Donation Thanks

You have been asked to write a thank you letter to Mrs. Kristine LeBon for her donation.

a) Inanew document create the following letter, allowing Word to wrap the text. Create
the letter using the block style:

123 Whippo Lane
Butler, PA 16001-7896
January 9, 2006

Mrs. Kristine LeBon

17 North Main St.

Reedsburg, GA 04459-2233

Dear Mrs. LeBon:

[ am writing to thank you for your very generous donation to the Sarah Bernstein
Memorial Library. We are always appreciative of donations, both monetary and
otherwise.

Asyou are well aware, our library has needed new carpeting for several years
now. The old rugs were an ugly avocado color. The new carpeting not only looks
beautiful, but will also help keep the environmental conditions good for books.

Thanks again from the gang at the Sarah Bernstein Memorial Library.

Sincerely

Chris Warheit
Library Assistant

b) Check the document on screen and correct any errors and misspellings. Remove the
red wavy line line from correctly spelled words.
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c) Save the letter naming it Donation Thanks.

d) Make the following changes:

Delete the word very in the first sentence.

Use the thesaurus to change the word appreciative in the first paragraph to an
appropriate synonym.

Add the following sentence to the end of the first paragraph in the body of the letter:
Your donation was truly a welcome surprise.

Delete the sentence The old rugs were an ugly avocado color. in the second paragraph
in the body of the letter.

Change good for books to favorable for printed materials at the end of the second
paragraph in the body of the letter.

Change the gang to all of us in the third paragraph in the body of the letter.

Change Chris Warheit to your name.

e) Check the document on screen and correct any errors and misspellings.

f) Save the modified Donation Thanks and then print a copy.

Exercise 3

Leadership

Effective leaders are key to a successful business. Learn more about leadership skills by completing
the following exercise.

a) Inanew document, type the following essay, allowing Word to wrap the text:

Leaders in any business environment are viewed as role models and visionaries
for those who work with them. Effective leaders tend to possess similar
characteristics, such as approachable, responsible, wise, and sensitive.

An effective leader is always organized and enthusiastic. An effective leader
knows how to delegate and utilize the strengths of their employees.

b) Check the document on screen and correct any errors and misspellings.

c) Save the document naming it Leadership.

d) Make the following changes:

¢ Change the word wise to knowledgeable in the first paragraph.

¢ Change the word effective to successful in the second paragraph. Use the gram-

mar checker to correct the grammatical error that occurs as a result of changing the
word.

* Add a third paragraph with the text: Leadership skills can be learned. Individuals

who would like to become leaders should become accessible and approachable,
be willing to share the credit with colleagues, and take initiative.

e) Save the modified Leadership, preview the document, and then print a copy.
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Exercise 4 Cover Letter

It is common practice to include a cover letter with a résumé or portfolio when applying for a job. A
cover letter should be in the block style and addressed to a specific individual and company. The first
paragraph should indicate the position being applied for and give the location and date of the advertise-
ment. The second and possibly third paragraph should expand in detail upon qualifications pertinent
to the job. The concluding paragraph should request an interview, state contact information, and thank
the reader for his or her time and consideration.

a) Given the following job advertisement from the Sun News on August 24, 2006, create
a cover letter:

Part-Time Sales Position

Creat opportunity for a student. Part-time position in busy retail clothing store.
Hours are 5-9 p.m. three days a week and 9-5 p.m. on Saturdays. Need to be
motivated and a self-starter. Salary includes wage plus commission. Send or
e-mail cover letter and résume to:

Ms. Jessica Wilson, Manager

Clothes and More

678 Palm Blvd.

Boca Raton, FL 33427-5314

clothesandmore @lpdatafiles.com

b) Check the document on screen and correct any errors and misspellings.

c) Save the document naming it Cover Letter Name where Name is your name.

d) Collaborate with another student in the class. E-mail or give your peer a copy of the
file so that it can be proof read with tracking turned on.

e) Evaluate your peer’s letter. With tracking turned on, make at least three “suggested”
edits along with any necessary edits, such as formatting or grammatical errors.

f) Use the Reviewing toolbar to accept and reject suggestions by your peer.

g) Save the modified letter, preview the document, and then print a copy.

Exercise 5 Complaint Letter

You have recently organized the senior prom. The catered food at the prom arrived an hour late, was
cold, and the menu was different than what was agreed to. You have decided to write a letter of com-
plaint to the manager of the catering company asking for a refund.

A letter of complaint should be brief and to the point. All relevant facts should be included, the action
wanted should be clear, and the tone of the letter should be reasonable. One appropriate format is to
write about the problem in the first paragraph, state the solution in the second paragraph, and then
give a deadline for a response in the last paragraph.

a) In a new document create a letter of complaint in the block style. Address the letter
to:

Mr. William Thomas
Catering Manager
Catering For All Occasions
43-901 Airport Way
Detroit, MI 48225
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b) Check the document on screen and correct any errors and misspellings.
¢) Save the document naming it Complaint Letter Name where Name is your name.

d) Collaborate with another student in the class. E-mail or give your peer a copy of the
file so that it can be proof read with tracking turned on.

e) Evaluate your peer’s letter. With tracking turned on, make at least three “suggested”
edits along with any necessary edits, such as formatting errors or spelling mistakes.

f) Save the edited letter and return it to your peer.

g) Use the Reviewing toolbar to accept and reject suggestions by your peer. Save the
modified letter.

h) Preview the document and print a copy.

Exercise 6 Poem
An occasional poem is a poem written for a special occasion, such as a birth, wedding, inauguration,

victory, or dedication.

a) In a new document create an occasional poem. The poem should be from four to 16
lines. Use the thesaurus in Word to find synonyms and antonyms.

b) Check the document on screen and correct any errors and misspellings.

¢) Save the document naming it Poem, preview the document, and then print a copy.

Exercise 7 COMPUTER MAINTENANCE

A regular maintenance routine will help keep your computer in good condition. A maintenance routine
should include cleaning the computer, maintaining the hard disk, and regularly updating virus protec-
tion and operating system software. COMPUTER MAINTENANCE contains some tips about keeping
a computer in good condition. Open COMPUTER MAINTENANCE, which is a Word data file for this
text, and complete the following steps:

a) Type your name below the “Computer Maintenance” title.

b) Center align and bold the title “Computer Maintenance” and format it as Tahoma 14
point.

c) Leftalign and bold the following headings and format them as Tahoma 12 point:

“Cleaning the Computer”
“Disk Maintenance”
“Updating Virus Protection and Operating System Software”

d) Input devices are devices from which the computer can accept data. Two input devices
are discussed in the “Cleaning the Computer” section. Format the first occurrence of
each input device name as italic.

e) Output devices are devices that display or store processed data. One output device
is discussed in the “Cleaning the Computer” section. Bold the first occurrence of the
output device name.

Using a Word Processor 123




f) The “Disk Maintenance” section lists an example of an operating system. Format the
name of the listed operating system as bold and italic.

g) The “Updating Virus Protection and Operating System Software” section explains
what must be downloaded on a regular basis to protect against new viruses. Format
the name of the download as bold and italic.

h) Save the modified COMPUTER MAINTENANCE and print a copy.

Exercise 8 Entertainment Review
The local newspaper has an opening for an entertainment critic. A review should include:
¢ Title
¢ Name of movie, concert, play, art show, or event
* Date of review
¢ Intended audience (young children, children, teen, young adult, adult)
* Rating, if applicable (G, PG, PG-13, and so on)
¢ Type of movie, music, play, art, or event
¢ Name of producer or gallery
¢ Name of director, if applicable
e Name of actors, band members, artist, headliner, or main attraction

* Summary of the movie or play, without giving away surprise moments
or the ending

¢ Comparison to similar movies, concerts, plays, art shows, or events
* Your overall rating
a) Inanew document create a half-page review of a recent movie, concert, play, art show,

or similar event that you attended. A review should be written based on facts and
without bias. Be sure to include the appropriate information as listed above.

b) Create a center aligned, bold title that has the name of the event that was reviewed. Be
sure there is a blank paragraph between the title and the first paragraph.

¢) Format any titles in the review as italic, such as the title of a movie or a song title.
d) Justify the body of the review.

e) Select Tools = Word Count to display the number of words in the document. Add a
paragraph to the end of the review that includes your name and the number of words
in the article.

f) Check the document on screen and correct any errors and misspellings.

g) Save the document naming it Entertainment Review and print a copy.
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Exercise 9 PROPOSAL

Dr. Ellie Peterson and Dr. Jeremy Prow are studying coral reefs off the coast of Florida. They have cre-
ated a funding proposal for their coral research.

a) Open PROPOSAL, which is a Word data file for this text, and make the following
changes:

¢ Change the heading so it reads A PROPOSAL FOR CORAL RESEARCH at the
top of the page.

* Change the word effect to affect in the “Summary” paragraph.
* Change the word accomplish to complete in the “Summary” paragraph.

¢ Delete the text state of the art in the “Purpose and Description” paragraph.

b) Check the document on screen and correct any errors and misspellings.

c) Center align and bold the headings “A PROPOSAL FOR CORAL RESEARCH” and
“GROWTH STUDIES OF CORAL ON SOUTH FLORIDA REEFS.”

d) Format the headings “Summary,” “Purpose and Description,” “Coral,” and
“Computerized Guide” as italic.

e) Center align and bold the “BUDGET” heading and format it in a larger font size.

f) Find the word greater in the proposal and then use the thesaurus to replace it with a
synonym.

g) Replace all occurrences of aging with growth.
h) Save the modified PROPOSAL.

i) Print only page 1. (Refer to Chapter 1 for information on printing single pages.)

Exercise 10 Vacation

In a new document create a one-page description of your last vacation. Describe where you went, how
you traveled, what you saw, and what you did. Include a hyperlink to a Web site that contains additional
information about the vacation area. Check the document on screen for errors and misspellings and
make any corrections. Save the document naming it Vacation and print a copy.

Exercise 11 TAKING TESTS

The TAKING TESTS document gives directions on how to take a test, but the steps are listed out of order.
Open TAKING TESTS, which is a Word data file for this text, and complete the following steps:

a) Use the Cut and Paste buttons on the toolbar to place the directions in proper order.
Be sure there is a blank line between each step.

b) Save the modified TAKING TESTS, preview the document, and then print a copy.
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Exercise 12 SCULPTORS
Five sculptors that lived during the late 19th and early 20th centuries are:

Sculptor Country
Constantin Brancusi Romania
Ronald Moody Jamaica
Ivan Mestrovic Croatia
Jacques Lipchitz Lithuania
Pablo Gargallo Spain

These sculptors were born in different countries and their art was influenced by events, movements,
and cultures of those years common to the artists.

a) Open SCULPTORS, which is a Word data file for this text. It contains information about
the five artists listed above. Cut and paste the paragraphs so that the country, artist’s
name, and description are in alphabetical order by country.

b) Save the modified SCULPTORS and print a copy.

c) Cutand paste the paragraphs so that the country, artist’s name, and description are in
chronological order by artist’s birth date.

d) Save the modified SCULPTORS and print a copy.

e) Usebooks or the Internet to research each artist and find the name of a work (a sculp-
ture), the materials used, and the year it was completed. Between each artist’s name
and biography, add the information about the artist’s work and include a hyperlink to
a Web site that contains additional information about the artist.

f) Save the modified SCULPTORS and print a copy.

Exercise 13 Short Soccer

The sports editor for your college newspaper likes the soccer article that you submitted. However, space
limitations require that the article be between 150 and 160 words.

a) Open SOCCER, which is a Word data file for this text.

b) Carefully read the article and determine which sentences and words are extraneous
and which are necessary to maintain the focus of the article.

¢) Inanew document, paste the text from the SOCCER article that still make a complete
story without losing the focus of the original article.

d) Select Tools = Word Count to display the number of words. Continue to edit the article
to meet the space limitations.

e) Save the document naming it Short Soccer.
f) E-mail the Short Soccer article as a document for review to: editor@lpdatafiles.com

g) Preview the document and print a copy.
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Exercise 14 Water Conservation

You have been asked to write an article about an environmental issue.

a) In Word, open and then print a copy of the WATER, CONSERVATION, and XERISCAPE
documents, which are Word data files for this text.

b) Inanew document create an article based soley on the documents printed in step (a).
Include a title, introductory paragraph, supporting paragraph(s), a closing paragraph,
and your name.

c) Under the title, type by Student Name replacing Student Name with your name and then
press Enter twice. You may need to point to the blue bar below “by” and then click the
AutoCorrect Options button and select Undo Automatic Capitalization if the word “by”
does not remain lowercase.

d) Bold the document’s title and format it as 14 point. Bold the byline and format it as
italic.

e) Justify the text in the body of the article.
f) Check the document on screen and correct any errors and misspellings.

g) Save the document naming it Water Conservation, preview the document, and then
print a copy.

Exercise 15 Grand Opening

You have opened a retail store. Your store could sell jewelry, clothing, sporting goods, or anything
else you wish. You will need a flyer to promote the grand opening of your new store. A flyer is a one-
page document that is sent in the mail, hand delivered, or left out for pick up. The intended audience
is prospective customers residing in the area of the business location. A flyer should have large ele-
ments to catch the reader’s attention so that the reader immediately knows the general topic. The rest
of the flyer should contain as much information as possible, including business name, address, phone
number, e-mail address, Web site address, and fax number. These elements can be smaller because the
flyer already has the reader’s attention. A flyer should also include coupons or other promotions to
draw the prospective customer into the store.

a) Inanew document create a flyer that will be sent to prospective customers announcing
your grand opening.

b) Assume the flyer will be printed in color and format the text appropriately. Decide
which text should be used to get the reader’s attention and make that text much larger.
Experiment with different fonts for the larger text, and choose one that is easy to read
and compliments your business. Experiment with different ways of emphasizing the
text.

¢) Bold all occurrences of the store’s name. Be sure each occurrence of the store’s name
is in the same color.

d) Format appropriate paragraph alignments throughout the flyer.
e) Check the document on screen and correct any errors and misspellings.

f) Save the document naming it Grand Opening.
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